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Getting Started

Once you login, you will be redirected to your E-Access homepage, containing a Navigation Toolbar, Quick Links,
and Alerts. It's best to navigate E-Access using the “back” links and “return” links in the system rather than the back
button in your Browser. The navigation toolbar and quick links contain the tools and features necessary for you to
view Upcoming CDO workshops/events and employer information sessions, upload your documents (resumes,
cover letters, etc), view and sign-up for On-Campus recruiting (OCR) interviews (which includes resume collections),
and track your applications.
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Updating Your Profile

The Profile displays personal and academic information for students to view/edit, as well as Privacy information.
NOTE: do not skip this step; it's an important piece that will be necessary when applying to positions.

1. Click on Profile from the navigation bar at the top of the page.
2. Complete the forms for Personal information, Academic information, and Privacy

My Documents

There are 3 ways to apply to jobs in E-Access, indicated in the Application Status box of each job:

1) Resume Referral: Your uploaded resume is sent via E-Access to employer.

2) On-Campus Recruiting: Your uploaded resume is sent via E-Access to employer.

3) Apply Directly to Employer: Follow employer instructions. Uploaded resume cannot be sent through E-Access. If
you do not have your resume available on the computer you are working on, you may download it from E-Access and
attach it to an e-mail when applying directly to employers.

***NOTE: All resume referral and on-campus recruiting positions require that at least one resume is
approved by the CDO. You can check the status of your uploaded resume in the My Documents tab.

See "Applying to Jobs" section for more information.



Uploading Your Resume

1. Select My Documents from the navigation bar at the top of the page.

2. Click Add New to enter a new resume. Use a previously created and saved resume to complete this
process.

3. Insert a label (i.e. “Jane Doe”) for your resume. Remember to name the resumes appropriately since the
company will see the name when they log into their account.

4. Click Browse to search for your resume from your hard drive, disk or flash drive.

5. Click Submit.

6. Once your first resume has been approved you will be able to preview your resume by clicking on the
resume title (in the Approved Documents Tab). A status of Ready indicates the document can be used.
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Resume Formatting Tips

As with

any document transmitted over the Internet, minor formatting errors may occur. E-Access uses PDF

technology.

It is recommended that you use common fonts such as Times Roman or Arial to ensure that resumes print
correctly for all employers. Font effects such as outlines and shadows may cause even simple fonts to
convert improperly.

One-inch margins are recommended. If your original document has small margins, the conversion might
cause words to wrap and throw off the formatting.

Use left-justification instead of full-justification which can also affect the formatting of your resume.

Avoid the three Ts: Templates, Text boxes, or Tables in your resume since they may not display correctly.
To preview a resume to ensure proper formatting click on the resume title in “Documents.”

If you see unintentional symbols in your preview, it may be that you need to try a new font. Change the font
in your original document, and then re-save and re-upload the file. This is also true if you use certain bullets
in your resume.

If when you upload your resume, the first page is blank it may be a formatting issue in Microsoft Word so try
these two options:



o0 Open up your resume in Word and Go to File > Page Setup. Click on the Layout tab. Make sure
Section Start is set at New Page or Continuous. Click on the OK button.

= |f that does not work then:

0 Goto Insert > Page Numbers. Click on the Format button. Make sure the Page Numbering is set at
Continue from Previous Section or Start at Page 1. Click the OK button. On the Page Numbers
window, uncheck the box that reads, "Show number on first page.” Click on the OK button

Cover Letters and Transcripts

Cover letters and transcripts can be uploaded to Documents by following the instructions for uploading your resume.
As a general rule, you should always include a cover letter with your resume when applying for a position. A cover
letter allows you to more thoroughly articulate to the employer why your background is an ideal fit for a particular
position. It is worth repeating, however, that in almost any other circumstance, you should include a cover letter
when responding to a job advertisement in a newspaper, on-line (e.g., CareerBuilder, Monster.com) or any other
advertising vehicle.

Some organizations will want you to supply an unofficial transcript before scheduling an interview so they can review
your academic background. If a transcript is requested, follow the same procedure that you use to submit your
resume. First make a copy of your unofficial transcript. You can copy your unofficial transcript from Banner or retype
your entire transcript and save it as a Word document on your computer. After you save your transcript as a file,
simply upload it to the My Documents link in E-Access by selecting “Unofficial Transcript” under Document Type. If
an employer has requested your transcript, you must include it when you submit your resume.
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Job & Internships
To do a general search for jobs or internships

Click Jobs & Internships tab, and then click Search Job & Internships.
Under Show Me; select All Opportunities

Select the desired Positions Type

Click Search.

PobdE=

To only search On-Campus recruiting or resume referral

1. Click All On-Campus Recruiting under Show Me; select your desired Position Type. To maximize your
search results, leave all search options open.

2. Click Search.
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Employers

The Employers tab lists all registered Employers with links that lead to information about the company and any
available Contact information. Students may also download an Excel file of their Favorite Employers from the
Favorites tab.
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My Interviews

The My Interviews tab contains all Interview Requests and Scheduled Interviews.
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Events

The Events section will list CDO Workshops, Information Sessions, and Panel Presentations (please disregard
the N/A section which is currently not active). Clicking the name of an event will give the student the ability to RSVP.

Company Information Sessions

We strongly urge you to attend all Company Presentations in which you have an interest. These sessions provide
information on the company (it's a great way to network and gather detailed information on a specific organization).

If an organization you are interviewing with hosts an Information Session (often the night prior to the interview date),
it is mandatory for you to attend.
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Calendar

The Calendar section displays the CSM calendar and contains events and scheduled interviews in Day, Week,
Month, and Year view. There is also space for personal events. This is also great way to quickly see who is coming
to campus for info sessions as well as upcoming CDO workshops.

Applying to Jobs

1. Click on the Job Title to view information on:
e Organization
Quialifications
Position description
Contact information
Interview date
Timeline for submission and interview sign up
Requirements for submission (resume, transcript)

2. Apply by selecting your resume (as well as any additional documents required to apply for the position) from
the drop down menu and clicking “Submit” during the resume submission period. These dates may be
found under “Schedule Details” on the right hand side.
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3. Select the resume and additional required documents you wish to send and click Submit.

NOTE: The ability to see and sign up for on-campus interviews is tied to your qualifications and submission
deadlines. If your degree, major, cumulative GPA or work authorization does not match the requirements for an on-
campus interview, you may not be able to apply for the position through the system.



**To check your education information and Work Authorization, click Profile in the navigation toolbar.

Please note that even US Citizens must select a "Visa Type".
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regukation, and business consulting frameworks. This unigue academic aimospheare is ideal for
individuals who seek to develop their problem solving, reseanch, and com puter softwane skills while
gaining an understanding of various fechnigues of economic, financial, statistical, and strategic
analysis as well as knowledge of one or mulliple practice areas Responsibiliies of a Research
Analystinclude the collection and synthesis of economic and financial data, indusiny reseanch, and
academic research, the creation and programming of spreadsheets, databases, charts, and graphs,
and the development of regressions and other statistical analyses.

Location: Location

City
Cambridge

State
Massachusetts

Country
United States

Full Time
US Citizen, Permanent Resident, H-1 Visa, Restricted, None

Position Type:
‘Work Authorzation:
AccountinglAuditingBookkesping, Analyst, Business, Consulting, Financial ServicesPlanning

Job Function:

Qualifications: A successful Research Analyst candidate will possess the kollowing qualifications:

Cover

V| |4 Add New
Letter™ '
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Transcript™ | %] | 4 aAdd New

. Interview Date(s)

Cet 168, 2007

| Schedule Details

Schedule Type: Pre-Sslect

resume submission start date
August 16, 2007 12:00 am

resume submission end date
October 7, 2007 11:58 pm

+Bachelor's degree in economics, finance, statistics, accounting, com puter science, information
fechnology, information management, biological science, chemistry ora elated field,

= Ability to collect, synthesize, and summarizz data and information,

+Experience using spreadehests, statistical software, databases, andior graphic software.
+«High standands for work quality and attention o detail.

+ Ability to work well as part of a team, while also taking responsibility for your actions and meeting
deadiines.

+ Ability to s0/ve problems while exhibiting good judgment.

+ Ability to set priorities, meet goals, and be flexible in ferms of the pojects and analyses being
pursued,

+ A keen interest in applied research in aneas relevant to economic and financial research

Sign-Up Start Date
October 12, 2007 1200 am

Cancellations Start Date
Qctober &, 2007 12:00 am

Cancellations End Date
October 14, 2007 11:53 pm

Sign-Up End Date
Cctober 16, 2007 11:59 pm

4 Back |4 Add To Favorites | Print Preview || Print |

. Screening Criteria

>

‘Work Authorization
US Citizen Permanent Resident H-1 Visa Restricted Nons

Viewing Application History

This feature lets you keep track of all jobs you have applied to and all the on-campus interview opportunities you
have signed up for. It is important to check this regularly because it will let you know the status of all your
applications.

1. Click on My Interviews in the navigation toolbar at the top of the screen.

2. Click on Scheduled Interviews to view positions that you have been selected to interview for or Interview
Requests to view your interview status.

3. The status of your application will be announced under each position.
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Withdrawing or Changing a Resume after Submission to an Employer

You can view your resume submissions under Interviews. If the submission deadline has NOT passed, you may
edit your resume. To do so, click the Withdraw Application button and reapply with a new version of your resume.
If you edit the version that was submitted, the system will automatically update the document in ALL of your active
applications. However, if the submission deadline HAS passed your resume cannot be updated.



Signing Up for Interviews

If selected for an interview you will receive an email about your status as a preselect candidate or an alternate in
addition to the sign up dates. A link is included in this email to direct you to the sign up page. Additionally, you will
be notified under the Home link of the navigation toolbar under Alerts.

To sign up for interviews while logged in to your account.

Click on the tab titled Interview Requests to view positions for which you have been selected to interview.
Click Schedule Interview to sign-up for an interview time on the employer’s visit date.
Select a time slot by clicking on the radio button to the left of your desired interview time.

1. Click on Interviews in the navigation toolbar at the top of the screen.
2.

3.

4.

5. Click Submit.
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submit back to list

Available Sep 26, 200«
Dates”:

* INDICATES A REQUIRED FIELD

IS;?E&E 9:00 am - 9:30 am
10:00 am - 10:30 am
10:45am-11:15am
11:15am-11:45 am
1145 am-12:15 pm
1:00 pm - 1:30 pm
1:30 pm - 2:00 pm
2:00 pm-2:30 pm
3:00 pm - 3:30 pm
3:30 pm-4:00 pm
400 pm - 4:30 pm
4:30 pm-5:00 pm

submit back to list

Position Information

Division: N/A

Title: Sprocket Sales

Description: Full-time position selling sprockets across the nation.

Location: _gcation

City
MNew York

State
New York

Country
United States

Paosition Full Time
Type:

Desired Accounting, Acting, Actuarial Science, African Studies,

Major(s): American Studies, Anthropology, Applied Linguistics,
Applied Psychology, Applied Science, Archaeology,
Architecture, Archives, Art History, Art Therapy, Arts &
Humanities, Arts Administration, Biochemistry, Biology,

Need Help? Contact the E-Access Help Line at x4328 or email e-access@smith.edu. We also recommend that you come

to a drop-in appointment for one-on-one instructions.
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